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PIC32 入門

ユーザー ガイド

ご注意：この日本語版ドキュメントは、参考資料としてご使用の上、最新情報に
つきましては、必ず英語版オリジナルをご参照いただきますようお願い
します。



マイクロチップ テクノロジー社 ( 以下、マイクロチップ社 ) デバイスのコード保護機能に関する以下の点にご留意ください。

• マイクロチップ社製品は、その該当するマイクロチップ社データシートに記載の仕様を満たしています。

• マイクロチップ社では、通常の条件ならびに仕様どおりの方法で使用した場合、マイクロチップ社製品は現在市場に流
通している同種製品としては最もセキュリティの高い部類に入る製品であると考えております。

• コード保護機能を解除するための不正かつ違法な方法が存在します。マイクロチップ社の確認している範囲では、この
ような方法のいずれにおいても、マイクロチップ社製品をマイクロチップ社データシートの動作仕様外の方法で使用す
る必要があります。このような行為は、知的所有権の侵害に該当する可能性が非常に高いと言えます。

• マイクロチップ社は、コードの保全について懸念を抱いているお客様と連携し、対応策に取り組んでいきます。

• マイクロチップ社を含むすべての半導体メーカーの中で、自社のコードのセキュリティを完全に保証できる企業はあり
ません。コード保護機能とは、マイクロチップ社が製品を「解読不能」として保証しているものではありません。

コード保護機能は常に進歩しています。マイクロチップ社では、製品のコード保護機能の改善に継続的に取り組んでいます。
マイクロチップ社のコード保護機能を解除しようとする行為は、デジタルミレニアム著作権法に抵触する可能性があります。
そのような行為によってソフトウェアまたはその他の著作物に不正なアクセスを受けた場合は、デジタルミレニアム著作権
法の定めるところにより損害賠償訴訟を起こす権利があります。
本書に記載されているデバイス アプリケーションなどに
関する情報は、ユーザーの便宜のためにのみ提供されて
いるものであり、更新によって無効とされることがあり
ます。アプリケーションと仕様の整合性を保証すること
は、お客様の責任において行ってください。マイクロチッ
プ社は、明示的、暗黙的、書面、口頭、法定のいずれであ
るかを問わず、本書に記載されている情報に関して、状
態、品質、性能、商品性、特定目的への適合性をはじめと
する、いかなる類の表明も保証も行いません。マイクロ
チップ社は、本書の情報およびその使用に起因する一切の
責任を否認します。マイクロチップ社デバイスを生命維持
および / または保安のアプリケーションに使用することは
デバイス購入者の全責任において行うものとし、デバイス
購入者は、デバイスの使用に起因するすべての損害、請
求、訴訟、および出費に関してマイクロチップ社を弁護、
免責し、同社に不利益が及ばないようにすることに同意す
るものとします。暗黙的あるいは明示的を問わず、マイク
ロチップ社が知的財産権を保有しているライセンスは一
切譲渡されません。
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序章
はじめに

本文書には PIC32 を使用する新規ユーザーが、PIC32 のアーキテクチャの基本的な
ハードウェアとソフトウェアの理解が得られるようにして、PIC32 製品のソフト
ウェア開発をすぐに始められるようにするためのものです。

本文書は、どなたも得たいと思う PIC32 マイクロコントローラの概要の知識と、マ
イクロチップ社およびサード パーティのツール パートナにより提供される関連技術
資料について主に記述しています。

後ほど本文書で提供する段階的な手順を学習するためには、組み込みシステム開発
に関する基本的な理解と、C のプログラミング知識が必要です。

本章には PIC32 を使う際に役立つ一般的な情報が含まれています。下記のような項
目について記述しています。

• 本資料の構成

• 表記規則

• 参考資料

• マイクロチップ社のウェブ サイト

• 開発システムに関するカスタマ変更通知サービス

• カスタマ サポート

• 文書の改版履歴

顧客の皆様への注意

ドキュメントはすべて古くなります。本書も例外ではありません。マイクロチップ社のツールおよ
びマニュアルはユーザーのニーズを満たすために改良を重ねており、実際のダイアログやツールの
内容が本書に記載されているものと異なる場合があります。最新のドキュメントを入手するには、
弊社のウェブ サイト (www.microchip.com) をご覧ください。

ドキュメントは「DS」番号で識別されています。この識別番号は、各ページのフッタ部分、ページ
番号の前に記載されています。DS 番号の表記規則は「DSXXXXXA」で、「XXXXX」が文書番号、

「A」が文書のリビジョン レベルを表しています。

開発ツールについての最新情報は、MPLAB® IDE のオンライン ヘルプをご覧ください。[ ヘルプ ]
メニューを選択して、次に [ トピック ] を選択すると、利用できるオンライン ヘルプ ファイルのリ
ストが表示されます。
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本資料の構成

本文書は、6 章に分かれています。第 1 章から第 4 章までは、PIC32 製品の概要につ
いて記述しています。第 5 章は PIC32 用開発ツールの概要について記述しています。
第 6 章は開発環境のセットアップとサンプルのアプリケーションのデバッグ手順に
ついて記述しています。本文書は下記のような構成となっています。

• 第 1 章「PIC32 の特徴」

• 第 2 章「PIC32 製品ファミリ」

• 第 3 章「PIC32 のアーキテクチャ」

• 第 4 章「PIC32 用ツール」

• 第 5 章「デモ プロジェクトのセットアップ、ビルド、実行までの段階的手順」 
• 第 6 章「技術サポート資料」
DS61146B_JP - ページ 2 © 2009 Microchip Technology Inc.



序章
表記規則

下記の表記規則が本文書で使われています。

表記上の規則

説明 意味 例

明朝フォント :

斜体文字 参考資料 MPLAB® IDE User’s Guide

強調文字 ... は唯一のコンパイラです ...

角括弧 : [ ] ウィンドウ [Output] ウィンドウ

ダイアログ [Settings] ダイアログ

メニューの選択肢 [Enable Programmer] を選択

かぎ括弧 :「」 ウィンドウまたはダイアログ
のフィールド名

「Save project before build」

右山括弧 (>) を使用し、
角括弧で囲まれた下線付き
イタリック テキスト

メニュー パス [File] > [Save]

太字で角括弧に囲まれた
テキスト

ダイアログのボタン [OK] をクリックします。

タブ [Power] タブを選択します。

N‘Rnnnn Verilog 形式の数です。N が
合計桁数、R が基数、n が桁
を表します。

4‘b0010, 2‘hF1

山括弧で囲まれた
テキスト : <>

キーボードのキー <Enter>、<F1> を押します。

クーリエ フォント :

通常のクーリエ サンプル ソース コード #define START

ファイル名 autoexec.bat

ファイル パス c:\mcc18\h

キーワード _asm, _endasm, static

コマンド行オプション -Opa+, -Opa-

ビット値 0, 1

定数 0xFF, ‘A’

イタリック クーリエ 変数の引数 file.o: fileは任意の有効
なファイル名

角括弧 : [ ] 任意の引数 mcc18 [オプション] file 
[オプション ]

中括弧とパイプ文字 : { | } いずれかの引数を選択する
場合 (OR 選択 )

errorlevel {0|1}

省略記号 : ... 繰り返されるテキスト var_name [, 
var_name...]

ユーザーが定義するコード void main (void)
{ ...
}

© 2009 Microchip Technology Inc. DS61146B_JP - ページ 3
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参考資料

本ユーザー ガイドは PIC32 の使い方を説明しています。他の有益な文書を下記に示
します。次のようなマイクロチップ社の資料があり、補助の参考資料としてお勧め
します。

PIC32MX の Readme ファイル
PIC32 マイクロコントローラの使い方に関する最新情報については、PIC32 スタータ 
キットの CD のルート ディレクトリにあるファイル (ASCII テキスト ファイル ) をお
読みください。ファイルには最新の更新情報や本文書の発行時になかった問題が含
まれています。

Readme ファイル

その他のツールの使い方に関する最新情報は、PIC32MX スタータ キット インストー
ル　ディレクトリの Readmesサブ ディレクトリにあるツール専用の readme ファイ
ルをお読みください。ファイルには更新情報や、本文書の発行時になかった問題が
含まれています。

マイクロチップ社のウェブ サイト

マイクロチップ社では、ウェブ サイト www.microchip.com で、オンライン サポート
を提供しています。このウェブ サイトは、お客様がファイルや情報を最も簡単に入
手できる手段としてご利用いただけます。サイトをご覧になるには、各自、お好み
のインターネット ブラウザをお使いください。マイクロチップ社のウェブ サイト
は、以下の情報を含んでいます。

• 製品サポート－データ シート、エラータ、アプリケーション ノート、サンプル 
プログラム、デザイン リソース、ユーザー ガイド、ハードウェア サポート資
料、最新ソフトウェア リリースとアーカイブされたソフトウェア。

• 一般的な技術サポート－よくある質問 (FAQ)、テクニカル サポート要求、オン
ライン ディスカッション グループ、マイクロチップ社のコンサルタント プログ
ラム メンバー リスト。

• マイクロチップ社のビジネス － 製品選択、オーダー ガイド、マイクロチップ社
の最新プレス リリース、セミナーおよびイベントのリスト、マイクロチップ社
のセールス オフィス リスト、使用ディストリビュータと工場名。
DS61146B_JP - ページ 4 © 2009 Microchip Technology Inc.



序章
開発システムに関するカスタマ変更通知サービス

マイクロチップ社では、お客様が現在のマイクロチップ社製品の最新情報を入手で
きることをお手伝いするため、カスタマ通知サービスを継続して行っています。一
度ご登録いただければ、あなたのご指定した製品ファミリもしくはご興味のある開
発ツールに関して、変更、更新、改定もしくはエラータが発行される毎に E- メール
での通知を受けることができます。

登録するには、マイクロチップ社のウェブ サイト www.microchip.com にアクセスし、
[Customer Change Notification] をクリックし、指示に従ってご登録ください。

開発システム製品は下記の通り分類されます

• コンパイラ － マイクロチップ社の C コンパイラとその他の言語ツールに関する
最新情報で、以下を含みます。MPLAB C18 および MPLAB C32 C コンパイラ、
MPLAB LIB30 オブジェクト ライブラリアン

• エミュレータ － マイクロチップ社のインサーキット エミュレータに関する最新
情報で、MPLAB ICE 2000 と MPLAB ICE 4000 を含みます。

• インサーキット デバッガ － マイクロチップ社のインサーキット デバッガ、
MPLAB ICD2 に関する最新情報を含みます。

• MPLAB® IDE － マイクロチップ MPLAB IDE、 これは Windows® 用の統合開発環
境システム ツールに関する最新情報です。この項では MPLAB IDE、 MPLAB SIM 
シミュレータ、MPLAB IDE プロジェクト マネージャと一般的な編集、デバッグ
機能に的を絞っています。

• プログラマ － マイクロチップ社のデバイス プログラマに関する最新情報で、
MPLAB PM3 と PRO MATE® Ⅱデバイス プログラマと PICSTART® Plus、PICkit® 
1 および PICkit® 2 開発用プログラマを含みます。

カスタマ サポート

マイクロチップ製品のユーザーはいくつかのチャネル経由で以下のサポートを受け
ることができます。

• ディストリビュータもしくは販売特約店

• 地域販売オフィス

• フィールド アプリケーション エンジニア (FAE)
• テクニカル サポート

• 開発システム情報ライン

サポートが必要な場合は、ディストリビュータ、販売特約店もしくはフィールド ア
プリケーション エンジニア (FAE) にお電話ください。地域販売オフィスでも顧客の
サポートを行っています。販売オフィスとその所在地については本ドキュメントの
最後のページを参照してください。

テクニカル サポートはウェブ サイト http://support.microchip.com にてご利用いただけ
ます。

文書の改版履歴

リビジョン A (2007 年 10 月 )
• 本文書の初版リリース

リビジョン B (2008 年 3 月 )
• 更新
© 2009 Microchip Technology Inc. DS61146B_JP - ページ 5
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ノート :
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PIC32 入門

第 1 章  PIC32 の特徴
1.1 はじめに

PIC32 はマイクロチップ テクノロジ社が提供する 32 ビット ファミリの汎用目的の
マイクロコントローラです。80+ DMIPS の性能で、幅広いオンチップの周辺モ
ジュールを内蔵しています。工業用標準となっている MIPS テクノロジ社の M4K 
MIPS32 コアを採用しています。PIC32 ファミリのいずれも、マイクロチップ社の
他の PIC® マイクロコントローラと類似のプログラミング インターフェースを使用
しています。さらに、PIC32 マイクロコントローラは、16 ビットマイクロコント
ローラである PIC24FJ128GA ファミリとピン互換となっています。

1.2 ハイライト

PIC32 ファミリは、広範囲のアプリケーションで有効な数多くの機能を提供します。
下記の各項は主要項目で分類した重要な特徴を示しています。

性能

• 5 段のパイプラインを持った最高 80 MHz の MIPS M4K 32 ビット コア

• 高性能なハードウェアの乗算 / 除算ユニット－乗算は 1 クロック

• プログラマブルなユーザーおよびカーネル用メモリ分割でアプリケーションの
安定度を強化

• 多重レジスタ セットで割り込み応答遅延を削減

• ハードウェア補助により 1 サイクルでレジスタ ビット操作

• 128 ビット幅のフラッシュ メモリで個々の命令フェッチ時間を短縮

• 256 バイトの高速キャッシュ メモリは命令および ROM データ先読みバッファ付き

• CRC 演算とパターン ベースの転送終了機能を搭載した DMA コントローラが利用
可能

• USB デバイス、ホスト、デュアル ロール アプリケーションが可能な USB On-The-Go
コントローラを内蔵

• USB コントローラに専用の DMA インターフェースを内蔵

電源管理

• 2.3 から 3.6V で動作

• 全電圧範囲でフル スピード動作可能

• RUN、IDLE、SLEEP を含む多彩な省電力モード

• IDLE モード中も DMA で I/O 転送可能

• プログラマブルな周辺モジュール用クロック

• 個別の周辺モジュールの ON/OFF 制御と IDLE モード中の動作

• 多くのクロック源

拡張性

• 工業用で有名な MIPS32 互換の M4K CPU コアで 5 段のパイプラインを持つ

• 32 KB から 512 KB のフラッシュ メモリ オプションを持つデバイスの大規模ファミリ

• 64/100 ピンの 16 ビット マイクロコントローラの PIC24FJXXXGA ファミリとピン
互換
© 2009 Microchip Technology Inc. DS61146B_JP - ページ 7
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使いやすさ

• PIC® マイクロコントローラとよく似た周辺モジュール

• 標準の MPLAB® ツール群－ MPLAB IDE、MPLAB C32 C コンパイラ、MPLAB 
REAL ICE™ そして MPLAB ICD 2

• ソフトウェア周辺モジュール用ライブラリは、マイクロチップ社の 16 ビット マ
イクロコントローラ用のものと互換

• TCP/IP、16 ビット ファイル システムなどのマイクロチップ社が開発したミドル
ウェア モジュール
DS61146B_JP - ページ 8 © 2009 Microchip Technology Inc.
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第 2 章  PIC32 製品ファミリ
2.1 はじめに

PIC32 ファミリには、32 KB から 512 KB の範囲のフラッシュ メモリを持つ拡張性の
あるデバイスが含まれています。また、豊富な周辺モジュールを持っています－ 5 つ
のタイマ、16 チャネルの 10 ビット A/D コンバータ、SPI、I2C™、UART などの通信
インターフェース。

ファミリの種類、コアや周辺モジュールの特性の完全なリストについては、「PIC32MX
ファミリ データ シート」 (DS61143) を参照してください。

図 2-1: PIC32 MCU モジュール
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ノート :
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第 3 章  PIC32 のアーキテクチャ
3.1 はじめに

PIC32 ファミリ MCU は、MIPS M4K コアと強力な周辺モジュール、組み込みフラッ
シュと RAM メモリを一緒に結合することで、広範囲のアプリケーションに適用でき
ます。

図 3-1: PIC32 のブロック図
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2: いくつかの機能は、あるデバイスでは有効ではありません。
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プロセッサ コア

• MIPS M4K、5 段のパイプライン

• MIPS32 互換のリリース 2 命令セット

• MIPS16e™ コード圧縮でコード密度を最大 40% 改善

• GPR シャドー レジスタで割り込みハンドラの応答遅延を最小化

• ビット フィールド操作命令

• 高性能乗算 / 除算ユニット：

- 1 クロックで 32x16 乗算 1 回の最大演算レート

- 1 クロックおきに 32x32 乗算 1 回の最大演算レート

• スタティック実装：最小の動作周波数は 0 MHz
• 2.3 から 3.6V で動作、全範囲でフルスピード

• RUN、IDLE、SLEEP を含む低電力モード

メモリ

• 統一された 4 GB の仮想メモリ空間

• 固定のメモリ マップ変換 (FMT) メカニズム

• 柔軟に分離可能なカーネルとユーザー アクセス メモリ セグメントによりアプリ
ケーションの安定性向上

先読み用キャッシュ

• 128 ビット幅 16 行の命令先読みバッファ

• 行のロードとロックを可能化 ― フラッシュに SW ブレークポイントを設定する
のに便利かつ割り込み応答遅延を最小化

割り込みコントローラ

• 95 個の IRQ ( 割り込み要求 ) までサポートする単一または多重ベクタ モードを
持つ完全にプログラマブルな割り込みコントローラ

• ベクタごとに多重優先順位とサブ優先順位を持つ

• 最高優先順位割り込みは専用レジスタ セットで割り込み応答遅延を削減

DMA コントローラ

• 4 つまでの独立チャネル

• メモリからメモリ、メモリから周辺モジュール、周辺モジュールからメモリへの
転送可能

• どの IRQ からでも可能なプログラマブルなトリガ

• チェイン化可能なチャネル、一致検出で停止、自動化可能なモード

• コアがアイドル中でもデータ転送可能

• プログラマブルな CRC エンジンを内蔵、データ転送中に計算可能

強化版パラレル マスタ ポート

• 8 および 16 ビットのデータ インターフェース

• 16 ビットまでのアドレス ライン、GPIO ラインで拡張可能

• 2 つのチップ選択ライン
DS61146B_JP - ページ 12 © 2009 Microchip Technology Inc.
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通信チャネル

• USB2.0 準拠 (FS.12 Mbps)、OTG、ホストまたはデバイスのみが可能

• 2 チャネルの強化版 UART、ハードウェアによる IrDA® 付き

• 2 チャネルのマスタ / スレーブ / フレーム モードの SPI
• 2 チャネルのマスタ / スレーブ I2C チャネル、10/7 ビット モード アドレッシング、
ブロードキャストが可能

アナログ－デジタル コンバータ

• 16 チャネルまで、10 ビット分解能の ADC
• 最大、500+ キロサンプル / 秒 (ksps) の変換速度

• ソフトウェアで選択可能な内蔵または外付け電圧リファレンス

• 自動チャネル スキャン モード

• 選択可能な変換トリガ源

• 16 ワードの変換結果収納バッファ

• 選択可能なバッファ充填モード

• 8 種の結果形式オプション

• CPU がスリープ モード中も動作

タイマ

• 5 個の 16 ビット タイマ / カウンタ、(2 個の ) 32 ビット タイマ / カウンタも構成
可能

• ソフトウェアで選択可能な内蔵および外付けクロック源

• 組み込み発振器とで非同期タイマ / カウンタ可能

• プログラマブルな割り込み発生と優先順位

• ゲート化外部パルス カウンタ

• ソフトウェア選択によるプリスケーラ

• CPU がスリープ モード中も動作

コア タイマ

• CPU 内に実装された 32 ビット タイマでタイマ割り込み機能を実現

RTCC (リアル タイム クロック カレンダ)
• 時分秒の時間

• 年、月、日、曜日のカレンダ

• うるう年検知

• 柔軟な設定のアラーム

• クリスタルの誤差を 260 ppm まで較正可能

デバッグとプログラミング

• 6 命令および 2 データのブレーク ポイント

• 2 個の複合ブレーク ポイント ロジック ブロックで、適格 / 優先ブレークポイント
トリガ、パス カウンタ、ストップウォッチ タイマが可能

• 4 線式 EJTAG と 2 線式マイクロチップ インターフェース

• 2 線式マイクロチップ インターフェース

- 6 個のリアルタイム 読み出し / 書き込みキャプチャ ロジック インターフェース

- CPU の動作を停止しなくても全 RAM と SFR の読み出し / 書き込みアクセス可能
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• 命令トレース用ポート

- 5 線式、無影響のトレース ポート

- 複合ブレークポイント ロジック ブロックによりトリガ可能

GPIO

• 5V に耐える入力

• 個別にオープンドレインが有効 / 無効可能な出力ピン

• 個別に弱プルアップが有効 / 無効可能な入力ピン

• 選択した入力のモニタと不一致条件による割り込み生成

注 : 入力ピンの弱プルアップと不一致で割り込みを生成する機能は、選択し
た I/O ピンだけで有効となります。
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第 4 章  PIC32 用ツール
4.1 はじめに

PIC32 マイクロコントローラは MPLAB 統合開発環境と、その中の全範囲に渡るハー
ドウェア、ソフトウェア ツールによりサポートされています。

4.2 ハイライト

本章では下記項目を説明しています。

• MPLAB IDE
• MPLAB C32 C コンパイラ

• 周辺モジュール用ライブラリ

• ソフトウェア ソリューション

• デモ、開発および評価用ボード

• 技術文書

4.3 MPLAB IDE
マイクロチップ社の MPLAB IDE は無償の開発用ツール セットでマイクロソフトの
Windows® に準拠しています。

• すべてのデバッグ ツールが単一のグラフィカル インターフェースで対応

- シミュレータ

- プログラマ

- エミュレータ

- インサーキット デバッガ

• コンテキストのコードを色分けするフル機能のエディタ

• プロジェクト マネージャ

• 編集可能なコンテンツを設定できるカスタマイズ可能なデータ ウィンドウ

• 高級言語のソース コードでデバッグ

• 豊富なオンライン ヘルプ

MPLAB IDE は、ターゲットのプロセッサ / 開発ボードに接続した次のようなプロー
ブを使って、高度なデバッグとプログラミング機能を提供します。

• MPLAB ICD2 インサーキット デバッガ：安価なランタイム開発ツール

• MPLAB REAL ICE インサーキット エミュレータ：高速なエミュレータでハード
ウェアおよびソフトウェアのトレース機能を持つ

• FS2 JTAG プローブ：ファースト シリコン ソリューションズ社で開発されたもの
で、このプローブは 4 線の EJTAG インターフェースで PIC32 マイクロコント
ローラのデバッグとプログラムを行う

• MPLAB PM3 デバイス プログラマ：マイクロチップ社の汎用デバイス プログラ
マで開発と生産用に適す

• MPLAB SIM32 デバイス シミュレータ：多くの PIC32 周辺モジュールと CPU を、
選択したサイクルとクロック精度のモードで正確にシミュレートする
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4.4 MPLAB C32 C コンパイラ

MPLAB C32 C コンパイラ パッケージはアプリケーションの生成を可能とし、次のよ
うな主要ソフトウェア コンポーネントで構成されています ( 図 4-1 参照 )。
• PIC32-gcc コンパイラ：ANSI C コンパイラに完全準拠で強力な統合化と効率的
なコード最適化が可能。コンパイラは MPLAB IDE デバッガが使うシンボル情報
も提供する

• PIC32-gpp マクロ プロセッサ：コンパイル前にプログラムを変換するためコン
パイラにより自動的に使われる

• PIC32-as アセンブラ：フル機能のマクロ アセンブラ

• PIC32-ld オブジェクト リンカ：アセンブラ / コンパイラで生成されたリローケ
タブルなオブジェクトをプリコンパイルされたライブラリのオブジェクトとリン
クする

• PIC32-ar アーカイバとライブラリアン：プリコンパイルしたコードのライブラ
リ ファイルの生成と変更を管理する

• PIC32-conv: ELF 実行ファイルを ASCII またはバイナリ形式に変換して、PROM
プログラマや評価ボードへのダウンロードに適したものとする

図 4-1: MPLAB® IDE 開発ツールのコンポーネント

MPLAB® IDE

MPLAB IDE コンパイラ
(PIC32-gcc)

MPLAB IDE アッセンブラ
(PIC32-as)

MPLAB IDE マクロ

プロセッサ
(PIC32-cpp)

MPLAB IDE リンカ
(PIC32-ld)

MPLAB IDE アーカイバ
(PIC32-ar)

ライブラリ

MPLAB IDE コンバータ
(PIC32-conv) MPLAB IDE デバッガ

MPLAB ICD 2
エミュレータ / プログラマ

MPLAB REAL ICE™
エミュレータ / プログラマ

MPLAB IDE シミュレータ

テキストエディタ
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4.5 周辺モジュール用ライブラリ

PIC32 MCU には多くのオンチップの高性能周辺モジュールが集積されています。

これらの周辺モジュールの使用を便利にするため、PIC32 用 MPLAB C32 コンパイラ
には 16 ビットのマイクロチップ社製 MCU と互換性のあるソフトウェアの周辺モ
ジュール用ライブラリが含まれています。周辺モジュール用ライブラリはソースと
オブジェクト形式で、詳細な API 解説ドキュメントと一緒に配布されています。
MPLAB C32 コンパイラを使用するソフトウェア アプリケーションは、ソース ファ
イル内に対応するヘッダ ファイルを単純にインクルードするだけで、周辺モジュー
ル ライブラリ関数を呼ぶことができます。－ つまり、MPLAB C32 コンパイラには
ライブラリのヘッダ ファイルとアーカイブ ファイル情報が組み込まれているという
ことです。

周辺モジュール用インクルードファイルは、C:\Program Files\Microchip\
MPLAB C32\pic32mx\include\peripheralにあり、ソース ファイル全体は対応
する周辺モジュールのサブディレクトリ内の C:\Program Files\Microchip\
MPLAB C32\pic32-libs\peripheralにあります。

周辺モジュール ライブラリには、次のようなインクルード ファイルが含まれています。
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表 4-1: 周辺モジュール用ライブラリ

周辺モジュール
ヘッダ
ファイル

説明

ADC adc10.h アナログ - デジタル コンバータをサポートするライブラリ

メモリ bmx.h 内部バス、メモリの配置と優先順を設定するバス マトリクス

用ライブラリ

アナログ コンパレータ cmp.h コンパレータ モジュールをサポートするライブラリ

コンパレータ用

電圧リファレンス

cvref.h コンパレータ用電圧リファレンスをサポートするライブラリ

DMA コントローラ dma.h DMA コントローラと CRC モジュールをサポートする

ライブラリ

不揮発性 ( フラッシュ )
メモリ

nvm.h フラッシュのイレーズ / 書き込み機能へのアクセスを提供

するライブラリ

I2C™ i2c.h I2C™ モジュールをサポートするライブラリ

入力キャプチャ incap.h 入力キャプチャ モジュールをサポートするライブラリ

割り込み int.h ベクタ割り込みコントローラをサポートするライブラリ

ロック lock.h システムのロックとアンロックをサポートするライブラリ

出力コンペア outcompare.h 出力コンペア モジュールをサポートするライブラリ

発振器 osc.h 発振器をサポートするライブラリ

先読みキャッシュ pcache.h 先読みキャッシュ モジュールをサポートするライブラリ

電力モード power.h スリープ、アイドル動作の電力モードをサポートする

ライブラリ

パラレル マスタ ポート pmp.h パラレル マスタ ポートをサポートするライブラリ

GPIO ports.h I/O ポートの設定と I/O データの読み書き用のライブラリ

リセット reset.h リセットの制御と状態用ライブラリ

RTCC rtcc.h リアルタイム クロックとカレンダをサポートするライブラリ

システム system.h システム レベルの動作用ライブラリ

SPI spi.h シリアル周辺インターフェースをサポートするライブラリ

タイマ timer.h 16 および 32 ビット タイマをサポートするライブラリ

UART uart.h 強化版 UART モジュールをサポートするライブラリ

ウォッチドッグ wdt.h ウォッチドッグ タイマ モジュールをサポートするライブラリ
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4.6 ソフトウェア ソリューション

本文書作成時点ではマイクロチップ社はドライバをリリースしていません。しかし
マイクロチップ社は主な通信周辺モジュール用のドライバを開発しています。

4.6.1 ミドルウェア

次のマイクロチップのミドルウェアが本文書作成時点で提供されています。

• SD メモリ用 16 ビット ファイル システムでマイクロソフトの MS-DOS ファイル 
システムをサポート

• 2 タイプの TCP/IP スタック－ 1) マイクロチップ社の従来の TCP/IP スタック－マ
イクロチップ社の 8 および 16 ビット用スタックと完全互換、2) マイクロチップ
BSD TCP/IPスタック－バークレイ ソケットAPIスタックで多くの先進機能を持つ

• TCP/IP 用ミドルウェア

- FTP サーバにより、ターゲットの PIC32 マシンで実行されるアプリケーション
でファイル転送プロトコル サーバが可能

- SNMP エージェントにより PIC32 製品を SNMP プロトコルで監視可能

- ウェブ サーバによりウェブ ブラウザ クライアントからの HTTP 要求を受け
入れ可能

• USB 用ミドルウェア

- USB 組み込みホスト用スタック (HID とマスストレージ )
- USB デバイス用スタック (HID、マスストレージ、CDC クラス )

4.6.2 サード パーティのツール

PIC32 をサポートする会社のリストについては、PIC32 のホーム ページ
(www.microchip.com/PIC32) をチェックしてください。
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4.7 デモ、開発、評価用ボード

PIC32 MCU 用の多様なデモ、開発、評価用ボードにより、フル機能のシステムです
ぐにアプリケーション開発ができます。大部分のボードにカスタム回路を追加する
ためのプロトタイプ用エリアがあり、さらに試験し変更するためのアプリケーショ
ン ファームウェアとそのソース コードが提供されています。これらのボードは、
LED、スイッチ、RS-232 インターフェース、LCD 表示器などの多くの機能をサポー
トしています。デモおよび開発用ボードを教育環境でも使うことができ、カスタム
回路の作り方や、多くのマイクロコントローラのアプリケーションについて学習で
きます。

現状では下記のボードがあります。

1. PIC32MX スタータ キット (DM320001)
2. PIC32 プラグイン モジュール付き Explorer 16 ボード (DM240001)

4.8 技術文書

現状の PIC32 MCU 用の文書は下記となります。

• アプリケーション ノート

- AN833, “Microchip TCP/IP Stack” (DS00833)
- AN1107, “HTTP Server for the Microchip BSD TCP/IP Stack” (DS01107)
- AN1108, “Microchip TCP/IP Stack with BSD Socket API” (DS01108)
- AN1109, “An SNMP Agent for the Microchip TCP/IP Stack” (DS01109)
- AN1111, “The Microchip FTP Server Using BSD Socket API” (DS01111)
- AN1140, “USB Embedded Host Stack” (DS01140)
- AN1141, “USB Embedded Host Stack Programmer’s Guide” (DS01141)
- AN1142, “USB Mass Storage Class on an Embedded Host” (DS01142)
- AN1143, “USB Generic Client on an Embedded Host” (DS01143)
- AN1144, “USB HID Class on an Embedded Host” (DS01144)
- AN1145, “Using a USB Flash Drive on an Embedded Host” (DS01145)
- AN1176, “USB Devcie Stack for PIC32 Programmer’s Guide” (DS01176)
- AN1166, “USB Generic Function on an Embedded Device” (DS01166)
- AN1163, “USB HID Class on an Embedded Device” (DS01163)
- AN1169, “USB Mass Storage Class on an Embedded Device” (DS01169)
- AN1164, “USB CDC Class on an Embedded Device” (DS01164)

• データシート

- DS61143 –  PIC32MX ファミリ データ シート

• ファミリ リファレンス マニュアル

- DS61132 –  PIC32MX ファミリ リファレンス マニュアル 
• コード例

- PIC32 の例は C:\ProgramFiles\Microchip\MPLABC32\examplesと
www.microchip.com/pic32 にあります

• エラータ (DS80350、DS80367)
• 移行文書 – 近日発行

• 設計ノート、コツとヒント – 近日発行

• 開発ツール注文ガイド – 近日発行
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第 5 章  デモ プロジェクトのセットアップ、ビルド、実行までの段階的手順
5.1 はじめに

この段階的な手順では、MPLAB プロジェクト マネージャ、エディタ、デバッガの
基本的な概念を紹介します。簡単なプロジェクトを作成することで MPLAB IDE のデ
バッグ能力を理解できるでしょう。

MPLAB IDE についての事前の知識は不要です。MPLAB IDE やそのコンポーネントの
完全な機能と包括的な技術の詳細については、ウェブ サイト (www.microchip.com/ide)
をご覧ください。

5.2 ハイライト

本章では下記項目について説明しています。

• MPLAB IDE のセットアップ

• 段階的なガイドの概要

• デバイスの選択

• プロジェクトの生成

• 言語ツールのセットアップ

• プロジェクトの名前付け

• プロジェクトへのファイルの追加

• デバッガの接続

• プロジェクトのビルド

• コードのテスト

5.3 MPLAB IDE のセットアップ

5.3.1 MPLAB IDE のインストール

MPLAB をシステムにインストールするには、提供されたインストール用 CD を使用
するか、マイクロチップ社のウェブ サイトから最新版 MPLAB IDE をダウンロード
して使います。

- CD-ROM からインストールするには、ディスクを CD ドライブに置くだけ
で、あとは画面の表示に従ってください ( ウィンドウズ エクスプローラを
使って CD-ROM メニューの menu.exeを見つけ実行してもできます )。

- MPLAB IDE をマイクロチップ社のウェブ サイトからダウンロードできた
ら、ファイルを解凍し、生成されたファイルを実行すればインストールされ
ます。

注 : MPLAB の PC へのインストールにはアドミニストレータのアクセス権利
が必要です。
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5.3.2 MPLAB IDE をアンインストールするには

- [Start] > [Settings] > [Control Panel] としてコントロール パネルを開く。

-「プログラムの追加 / 削除」を選択し、MPLAB IDE を探して選択する。

-「変更 / 削除」でプログラムをシステムから削除する。

5.3.3 MPLAB IDE の実行

MPLAB IDE を起動するには、インストール後、デスクトップにインストールされた
アイコンをダブル クリックするか、[Start] > [Programs] > [Microchip] > [MPLAB IDE 
vx.xx] > [MPLAB IDE] を選択します。画面に MPLAB IDE のロゴが表示された後、
MPLAB IDE のデスクトップが表示されます。

図 5-1: MPLAB IDE スタート画面

5.4 段階的なガイドの概要

PIC32 MCU で実行可能なコードを生成するためには、プロジェクトの一部として
ソース ファイルが必要です。その後選択した言語ツール ( アセンブラ、コンパイラ、
リンカなど ) を使ってコードをビルドして実行コードとします。MPLAB IDE の中で
は、プロジェクト マネージャがこのプロセスを制御し、これらの大部分のステップ
をガイドしてくれます。

すべてのプロジェクトは下記の基本ステップとなります。

- デバイスの選択

MPLAB IDE の機能は、どのデバイスを選択したかにより変わります。デバイス
選択はプロジェクト開始前に完了するようにしてください。

- プロジェクトの生成

MPLAB IDE プロジェクト ウィザードを使ってプロジェクトを生成します。

注 : MPLAB のアンインストールには、アドミニストレータのアクセス権利
が必要です。
DS61146B_JP - ページ 22 © 2009 Microchip Technology Inc.



デモ プロジェクトのセットアップ、ビルド、実行までの段階的手順
- 言語ツールの選択

プロジェクト ウィザードの中で言語ツールを選択します。このチュートリアル
では PIC32 ツールを使います。他のプロジェクトでは、他のマイクロチップ社
のツールやサードパーティのツールを選択することができます。

- プロジェクトにファイルを追加

プロジェクトにテンプレート ファイルとリンカ スクリプトを追加します。

- コード生成

ここで、テンプレート ファイルに対し、評価ボードに接続したシリアルのコン
ソールに「Hello World...」という文字列を出力する非常に簡単なコードを追加し
ます。これには、マイクロチップ社から提供されている UART 周辺モジュール
用ライブラリを使います。

- プロジェクトのビルド

プロジェクトをビルドします。－これでソース ファイルがコンパイルされリン
クされて、選んだ PIC32 MCU で実行可能な機械語になります。

- コードのテスト

最後に、コードを評価ボード上で実行してテストします。

5.5 デバイスの選択

IDE のトップメニューで [Configure] > [Select Device] とします。デバイス ダイアログ
では、ドロップ ダウン リストから PIC32 の種類を選択します。

図 5-2: MPLAB IDE のデバイス選択 

注 : 将来リリースされる製品ではユーザー インターフェースの見栄えが異なっ
ているかもしれませんので、本ガイドの画面コピーは今後の MPLAB IDE の
デスクトップに表示される画面と正確には一致しないかも知れません。
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「ランプ」は MPLAB IDE コンポーネントの本デバイスのサポート状況を表します。

- 緑色ランプはフル サポートを表します。

- 黄色ランプは、最新部品に対する特定 MPLAB IDE のツール コンポーネントの暫
定サポートを表します。黄色ランプのコンポーネントは、緑色ランプと異なり、
新部品を早期使用するユーザーに対する早期対応であり、機能や操作に一部未対
応があることがあります。

- 赤色ランプは、このデバイスでは未サポートであることを表します。将来サポー
トか、このツールは適していないことを示します。

5.6 プロジェクトの生成

次のステップはプロジェクト ウィザードを使ったプロジェクトの生成です。プロジェ
クトはファイルをまとめてコンパイル、アセンブル、リンクするためのものです。
ここでのプロジェクトでは 1 個の「C」ファイルとリンカ スクリプトを使います。

[Project] > [Project Wizard] と選択します。

Welcome ダイアログでは [ 次へ ] をクリックして先に進みます。

ステップ 1 のダイアログでは、デバイスが選択できますが、ここではすでに済ませ
ています。適切な PIC32 種別が表示されていることを確認してください。異なって
いる場合は、必要な PIC32 種類をドロップ ダウン メニューで選択してから [ 次へ ]
をクリックしてください。

図 5-3: MPLAB IDE デバイス選択のウィザード
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5.7 言語ツールのセットアップ

プロジェクト ウィザードのステップ 2 はこのプロジェクトで使う言語ツールのセッ
トアップです。[Show all installed toolsuites] チェックボックスにチェックが入ってい
ることを確認してください。[Active Toolsuite] リスト ボックスで「Microchip PIC32 C 
Compiler Toolsuites」を選択します。

これで [Toolsuite Contents] ボックスに「MPLAB PIC32 Assembler (PIC32-as.exe)」、
「MPLAB PIC32 C Compiler (PIC32-gcc.exe)」、「MPLAB PIC32 Object Linker 

(PIC32-ld.exe)」、「MPLAB PIC32 Archiver (PIC32-ar.exe)」が表示されるはずです。そ
れぞれをクリックしてその [location] を確認してください。MPLAB IDE がデフォル
トのディレクトリにインストールされていれば、これらのファイルのパスは下記の
ようになります。

• MPLAB PIC32 アセンブラ :
- C:\Program Files\Microchip\MPLAB IDE\ MPLAB 
C32\bin\PIC32-as.exe

• MPLAB PIC32 コンパイラ :
- C:\Program Files\Microchip\MPLAB IDE\ MPLAB C32\bin\ 
PIC32-gcc.exe

• MPLAB PIC32 オブジェクト リンカ :
- C:\Program Files\Microchip\MPLAB IDE\ MPLAB 
C32\bin\PIC32-ld.exe

• MPLAB PIC32 アーカイバ :
- C:\Program Files\Microchip\MPLAB IDE\ MPLAB 
C32\bin\PIC32-ar.exe

これらのパスが正常に表示されていない場合は、[Browse] ボタンを使って MPLAB 
IDE のサブフォルダ内の適切なファイルに設定してください。

完了したら [ 次へ ] をクリックします。

図 5-4: MPLAB IDE 言語ツール セットの選択
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5.8 プロジェクトの名前付け

ウィザードのステップ 3 では、プロジェクトに名前を付けフォルダに格納します。
ここでの例題プロジェクトは「MyTestProject」と呼ぶこととします。[Browse] ボタ
ンを使ってこのプロジェクトを「Project32」というフォルダに置くこととします。
[ 次へ ] をクリックします。

図 5-5: MPLAB IDE プロジェクトの名前付け
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5.9 プロジェクトにファイルを追加する

プロジェクト ウィザードのステップ 4 はプロジェクト用のファイルの選択です。こ
こでプロジェクトに必要なファイルを追加できます。この例題ではまだファイルを
生成していませんが、新プロジェクトの設定後に作成することができます。

そこですぐ [ 次へ ] をクリックして「Summary 画面」を表示させます。

図 5-6: MPLAB IDE Summary 画面

ここで [ 完了 ] を押し、ワークスペースのダイアログを表示させます。

図 5-7: MPLAB IDE ワークスペース保存ダイアログ
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ワークスペースを「Project32」のディレクトリに間違いなく保存します。このワー
クスペースの名前をプロジェクトと同じ「MyTestProject」とします。

[ 保存 ] をクリックします。

これでプロジェクト スペースが完全にできあがり下記のように表示されます。

図 5-8: MPLAB IDE プロジェクトの保存

では、C ソースファイルを作成しましょう。MPLAB IDE のエディタ ウィンドウが開
いていなければ、トップ メニューから [File] > [New] とクリックするか、標準ツール 
バーにある [New File] メニューのショートカットをクリックします。これでエディタ 
ウィンドウが開きます。

エディタ ウィンドウに非常に簡単な Hello World プログラムをタイプ入力し、
Project32 ディレクトリに main.cとして保存します。マイクロチップ社の UART 周
辺モジュール ライブラリを使います。
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図 5-9: MPLAB IDE の main.c ファイル

新規作成した main.cファイルをプロジェクトに追加するには、MPLAB IDE の
MyTestProject.mcp ウィンドウ内の [Source Files] フォルダを右クリックし、[Add File]
を選択します。Project32 ディレクトリから main.cをブラウズし選択します。

このプロジェクトに必要なリンカ スクリプトは MPLAB IDE により自動的に選択さ
れます。したがってこのプロジェクトにはあと何も追加する必要はありません。

注 : プロジェクト ウィンドウが表示されていない場合は、IDE のトップ メ
ニューで [View] > [Project] と選択してください。
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MyTestProject.mcp ウィンドウで右クリックして [Save] を選択します。これでテスト 
プロジェクトが保存されます。MyTestProject.mcp は下記のようになります。

図 5-10: MPLAB IDE でプロジェクトを保存

ヒント：ファイル追加とプロジェクトの保存は、プロジェクト ウィンドウでマウス
の右クリックをしてもできます。間違った場合は、ファイルをマニュアルで選択し
マウスの右クリック メニューで削除できます。
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5.10 デバッガの接続

PIC32MX スタータ キットを使ってコードをテストするときには、PIC32MX スタータ
キット ユーザー ガイド (DS61144) の例題プロジェクトと段階的入門の情報を参照し
てください。

本文書のコードのテストには、Explorer 16 開発ボード (DM240001) と、MPLAB REAL
ICE インサーキット デバッガ (DV244005)、それと PIC32MX360F512L PIM (MA320001)
を 9V の汎用電源と一緒に使います。また、REAL ICE を開発ボードに接続するため、
シリアル ケーブルと USB ケーブルを使います。

図 5-11: EXPLORER 16、MPLAB® REAL ICE™、PIC32MX360F512L PIM

REAL ICE と Explorer 16 開発ボードを確実に接続するには下記ステップのようにし
ます。

1. MPLAB REAL ICE を USB ケーブルで PC と接続する

2. MPLAB REAL ICE と Explorer 16 開発ボードを短い RJ-11 ケーブルで接続する

3. Explorer 16 ボードに電源を供給する

4. [Debugger] メニューから、[Select Tool] > [MPLAB REAL ICE] をクリックして
MPLAB REAL ICE を MPLAB IDE のデバッグ ツールとして設定する

5. [Debugger] メニューから [Connect] を選択してデバッガをデバイスに接続する。
MPLAB IDE が PIC32MX360F512L デバイスを見つけたことを出力ウィンドウ
にレポートします。

このステップが完了したら、MPLAB IDE のウィンドウに進み、[Debugger] > [Select 
Tool] メニューからボードに接続しようとしているデバッグ ツールを選択してくださ
い (MPLAB REAL ICE が有効な選択肢にあるはずです )。
ツールを選択すると、[Debug Toolbar] が選択可能な他のツールバーと一緒にメイン 
メニュー バーの下に現れるはずです。

注 : MPLAB REAL ICE を PIC32 デバイスと初めて使う場合には、MPLAB 
IDE が新しいファームウェアをダウンロードしようとします。それを許
可してください。

注 : MPLAB IDE の [Build Configuration] のドロップ ダウン リストから [Debug]
を選択するようにしてください。
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5.11 プロジェクトのビルド

[Project] メニューで現在のファイルのコンパイルとリンクができます。

プロジェクトをビルドするには、下記いずれかとします。

- [Project] > [Build All] 
- プロジェクト ウィンドウのプロジェクト名の上で右クリックし、[Build All] を選
択する

- プロジェクト ツール バーの [Build All] アイコンをクリックする。マウスをアイ
コンの上におけば、それが何かを示すポップアップ テキストで見られます。

出力ウィンドウにビルド経過が表示されます。どのステップにもエラーがないように
します。

図 5-12: MPLAB IDE プロジェクトのビルド

5.12 コードのテスト

最初に、ビルドしたプログラムの Hex イメージをダウンロードします。これには、
[Debugger] メニューから [Debugger] > [Program] とするか、「デバッガ ツールバー」か
ら直接プログラムします。プログラミング操作にもエラーがないようにします。

例題アプリケーションをテストするには、PC 側のセットアップも必要です。

シリアル ケーブルでボードの RS-232 コネクタと PC の COM ポートのどれかと接続
し、PC 上でハイパー ターミナル アプリケーションを開きます ([ プログラム ] > [ ア
クセサリ ] > [ 通信 ] > [ ハイパー ターミナル ])。
この接続に対応する名前を入力して [OK] をクリックします。それから、「接続の設
定」の画面で開発ボードと接続した COM ポートを選択します。
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図 5-13: ハイパー ターミナル接続画面

次の画面で [OK] をクリックし次の通信の設定に進みます。

• 通信速度：57600 bps
• データ ビット：8
• パリティ：なし

• ストップ ビット：1
• フロー制御：なし

[OK] をクリックすると、ハイパー ターミナルの開発ボードのシリアル ポートとの
接続が行われます。

これで MPLAB IDE に戻り、下記の行をダブル クリックします。

return nc;

こうして、MPLAB IDE のエディタ ウィンドウ内の main.cプログラムで、strlen()
を呼び出した直後の行にブレーク ポイントを設定します。

メイン メニューで [Debugger] > [Run] とクリックするか、デバッグ ツールバーの [Run]
をクリックします。プログラムが実行開始し、ブレーク ポイントまで進みます。
MPLAB IDE ウィンドウは下記と類似の表示になっているはずです。
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図 5-14: MPLAB IDE ブレーク ポイントに到達

1. デモ ボードに接続している選択したデバッグ ツール名

2. ターゲット ボード上の選択したデバイス名

3. デバッガ トップ メニュー下で有効なメニュー

4. デバッグ ツールバー

5. ソース ウィンドウ、ブレーク ポイントに到達

6. 逆アセンブル ウィンドウ

7. 出力ウィンドウ

8. プログラム メモリ ウィンドウ

PC 側のハイパー ターミナルのウィンドウを見ると、この簡単なテスト プログラムが
シリアル回線で送った出力を見られるはずです。

図 5-15: ハイパー ターミナルの受信文字

4

3

1

5

6

8

72
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また、Explorer 16 ボードを見ると、LED D9 が点灯しているはずです。

これは PIC32 Explorer 16 デモ ボードと MPLAB IDE が正常に動作していることを表
しています。

これで PIC32 の最初の「Hello World」プログラムができたことになります。

MPLAB IDE ではこれ以外にプログラム デバッグ用に多くのことができるようになっ
ています。

例えば、変数「nc」の上にマウスを置くと、その変数の実際の値を見ることができ
ます ( これは putsUART2()関数がシリアル ポートで送った文字数を示します )。
MPLAB IDE のその他のデバッグ機能

• ウォッチ ウィンドウ：周辺モジュールの SFR の変数をウォッチ ウィンドウに追
加して値をモニタできる

• 複合ブレーク ポイントの扱い

• 便利なデバッグ用コマンド：step into、step over など、C ソース ウィンドウと逆
アセンブル リスト ウィンドウの両方を使用

• コード実行内容のプロファイリング、プログラムの異なるポイント間の遅延時間
の計算などが可能

ここまでで、MPLAB IDE で PIC32 入門の基本的なステップを紹介しました。これで
PIC32 と MPLAB IDE の能力を使いこなす準備ができました。PIC32 に関する詳細情
報については、本文書でリストアップした文書をご覧ください。MPLAB IDE に関す
る詳細情報については、Design リンクに続く私どものウェブ サイト
www.micorchip.com から取り出せる「MPLAB IDE Quick Start Guide」(DS51281) をご覧
ください。
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PIC32 入門

第 6 章  技術サポート資料
6.1 はじめに

技術サポートに関する情報については、Support.microchip.com をご覧ください。
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